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1. The Rack in Detail 

 

The Rack Control Strip 

At the top of each Rack, there is a strip which controls the Rack and assigns it to processing 

groups. The control strip has the following windows and buttons: 

 

In/Out  Disables the Rack’s plug-ins and passes the signal directly from Rack 

input to Rack output. Typically used for “before and after” comparison or 

to bypass processing. 

Mute Silences the Rack, but doesn’t remove it from CPU processing. Muting is 

performed on the Rack’s input to allow reverb tails and delay taps to fade 

gracefully. 

Rack Name  Displays the Rack’s name. Double-click to rename. 

Group Name  

(“Drums” in this example) 

Refers to a latency alignment group to which the Rack may have been 

assigned. Use the pull-down menu to assign the Rack to another latency 

group. 
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Selecting Racks and Using Keystroke Commands 

Using a mouse, right click on the top part of a selected Rack and you will see a pull-down menu 

that offers several functions: 

 

Active(On) The Rack is always active. 

Bypass Disables the Rack’s plug-in processing and passes the signal 

from the Rack input to the Rack output. 

Mute Mutes the entire Rack but doesn’t remove plug-ins from CPU. 

Global Paste Rack Copies the Rack’s parameters from the recalled Snapshot and 

pastes them into the selected Snapshots when “Global Paste” 

is selected in the Snapshot Pane. For example, if your singer 

has a cold and you need to EQ the vocals differently, Global 

Paste allows you to change specific settings, then embed these 

parameter changes into all of the Snapshots you’ve made, 

rather than having to adjust each Snapshot separately. The 

Global Paste function is discussed in detail in the “Snapshots” 

section of this manual. 

Recall Safe Places the selected Rack or plug-in into a “safe” mode which 

protects it from Snapshot recalls. "Recalled Safe" racks or 

plug-ins are unaffected by all Snapshot recalls, even if a 

Snapshot has parameters that "should" be changed on 

Snapshot recall.  

Assign the Rack to a latency 

alignment group 

Presents a list of available latency alignment groups from 

which you can assign a latency group/s to a rack/s. 
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Latency Displays the Rack’s overall latency (accumulated inserted plug-

in latencies) 

CPU Consumption Displays the Rack’s CPU consumption (usage) on the 

SoundGrid Server and the core it runs on 

 

Input and Output Sections 

 

To the right of the Input Rail is the Input Audio Fader, with a range of ±18dB.  

On the far right side of each Rack are the Output Rail and the Output Audio Fader. Rack audio 

input and output levels are stored within Snapshots. 
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2. Adding Plugins to a Rack 

 

 

 

To add a plug-in to a Rack, touch the “plus” (+) sign to the right of the Input Fader. Select a 

plug-in from the pull-down menu. An icon representing the plug-in will appear on the Rack, 

along with a new “plus” (+) sign that you can touch to add a new plug-in to the right of the 

existing one.  

Signal flow within a Rack is always from left-to-right.  

While in the Main view (or Rack view), you can always change the plug-in sequence within a 

Rack by grabbing a plug-in and dragging it to the desired location. Each plug-in icon has an "In" 

switch that bypasses the processor without disengaging it from the Rack. There is also a Led 

indicator on the icon that shows plug-in output state: gray- no signal, green – signal, red- clip.  
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3. Rack View: Controlling Your Plug-ins 

 

Double touch a plug-in's icon to open its interface and enter MultiRack SoundGrid Rack view.  

     

Here you can adjust each plug-in parameter by selecting the parameter on screen and using the 

Touch-n-Turn knob or toggle to set the selected parameter. Some controls on selected plugins 

might appear too small for touch selection - please use Digico's keyboard with mouse for more 

precise operation. If you’re already familiar with Waves plug-ins, this window will be very easy to 

use.  

At the top of each plug-in window is a WaveSystem Toolbar, used to load, save, and compare 

processor settings. The layout of the WaveSystem Toolbar may vary from one plug-in to 

another. Use this toolbar to save plug-in or Rack-specific presets. 
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There are two quick ways to move from one plug-in to another within a Rack: 

1. Use your keyboard’s left and right arrows. This will move you through the list of plug-ins 

in the Rack, opening each plug-in interface as it is selected.  

Note: If you have selected a parameter for editing on the current plug-in, this will not 

work, and may change the parameter value instead. 

2. Touch another plug-in icon. This will move you directly to the new plug-in and open its 

window. 

  



 

 9 

4. System Toolbar Buttons 

 

 

Setup A (Setup B)  Toggles between two setups, allowing you to compare different settings. 

This facilitates quick A/B comparisons and lets you determine which of two 

settings works best without having to save a preset. An asterisk (*) on the 

button indicates that changes have been made since a preset was loaded.  

A►B; B►A  Copies the current settings to the second setup register. The direction of 

copying is from the currently shown setup to the one not shown.  

Load  Here you load factory presets, user presets, and other preset files. Factory 

presets are permanent elements of the Load popup menu, created by 

Waves. They cannot be changed or deleted. You can turn the current 

settings of the plug-in you’re using into a user preset by clicking the Save 

button. User presets can be changed and deleted, and the preset files you 

save through the toolbar will appear as Load menu presets until you close 

the preset file or close the plug-in. Some plug-ins have a very large library of 

presets, too large to display on the main pull-down menu. To load these 

library files or load presets from external files, select “Open Preset File.” 

Waves preset files are saved with an .XPS extension  

Save  Save your plug-in presets here. You can save the current parameters as a 

user preset in the Preset menu, or create a new file. If you choose to save 

the preset as a new file — outside the plug-in’s Preset menu — 

WaveSystem will ask you where you want to put it.  

 
Clicking on the Waves logo will bring up the “About This Plug-in” page, 

providing information about the plug-in. 
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5. Inserting a Rack into a Channel 

 

Below are two generic examples how you can use Waves plug-ins in your session, as an Insert 

and through an Aux. 

Example 1: Assigning Waves Plugins to a Channel Insert A  

To open Chxx Outputs dialog you have two options: 

1. Press on the console's “Screen Assign” Left or Right button, and select the desired 

channel, then touch Insert area to open sub-menu. Tap on Insert A on the Touch 

Screen.  

2. Touch Insert Aon the desired channel to open Chxx Outputs routing window. 

Set Routing: 

1. Click on Ins A Send. 

2. Set the Insert On 

3. In CHxx Insert Send Route window, click on send+return. 

4. In the Ports column, choose Waves.  

5. Choose the desired Signal Group.  

6. Under Signals, choose the desired Waves I/O. 

                



 

 11 

Example 2: Setting Rack as Parallel FX 

For this, we need to use an Aux channel (mono/stereo) and return it to any channel we choose. 

This means we need two types of channels: An Aux and an Input channel. 

The Aux channel:  

In the example below, we will use Aux01 (Mono). 

To open Aux01 Outputs dialog you have two options: 

1. Open Master channel view by pressing the "Screen Assign" on the console’s center 

section. Select the desired Master channel, and tap on Outputs. 

2. Touch Outputs to open the routing panel for the desired Master channel.  

Set Routing: 

1. Click on Output. 

2. In the Ports column, choose Waves.  

3. Choose the desired Signal Group.  

4. Under Signals, choose the desired Waves I/O. 
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The FX Return to an Input Channel 

In the example below, we will use Input Channel 12. 

To open Ch12 Setup dialog you have two options: 

1. Open Channel view by pressing the console's “Screen Assign” Left or Right button. 

Select the desired input channel for the FX Return, and touch Input area to open the 

Ch12 Setup. 

2. Touch Input area to open the Ch12 Setup for the desired Input channel. 

Set Routing: 

1. In Ch12 Setup window, click on Main Input. 

2. In the Ports column, choose Waves.  

3. Choose the desired Signal Group.  

4. Under Signals, choose the Waves I/O set for the Aux output from the previous section. 
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6. Rack Types: Mono, Stereo and Mono to Stereo 

 

 

Similar to outboard gear, MultiRack SoundGrid Racks are configured to work in different modes:  

 Stereo processing: Stereo Channel Insert, Master Channel, Stereo Groups, Stereo In-

Ears etc… 

 Mono processing: individual Mono Channels, Mono Aux EQ’s etc… 

 Mono to Stereo: Reverbs, Delays etc… 

MultiRack SoundGrid Racks types and names are set via the Console’s routing; depending on 

type of input (mono or stereo) MultiRack will automatically load the correct Rack type. 

       

For Mono to Stereo configuration (Reverb etc…), turn on mono>stereo button in the Output 

Routes when setting an Insert A/B or Output. 

 

Exceptions:  

a) Un-route mono channel from stereo Rack doesn't change the rack type to mono 

b)  Using ripple channels when patching Waves insert will not affect Rack type. 
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Setting up Side-Chain 
 

Each Rack can be set to receive Side-Chain from the MultiRack inputs. Side-Chain is used by 

some plug-ins to modify their behavior, e.g. to allow ducking by a compressor plug-in. A stereo 

Rack can receive a stereo or mono Side-Chain signal, a mono or mono-to-stereo Rack can 

receive a mono Side-Chain signal.  

1. In the Rack top section there is a drop-down menu titled Side Chain. In this menu you 

set the input that will be feeding the Side-Chain signal to the Rack. Select the input 

source you want to feed as Side-Chain to the Rack.  

 

2. Insert a plug-in with Side-Chain capabilities. A plug-in with Side-Chain capabilities is will 

be mark with (sc) after the plug-ins name.  
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3. Right-click on the plug-in and select Enable Side Chain from the drop down menu, this 

enables the Side-Chain for that respective plug-in. This can also be done by clicking in 

the SC button on the side of the Rack View (as shown below). 

 

4. A Side-Chain enabled plug-in is marked by a yellow SC button, and with the SC button 

on the side of the Rack View (as shown below)..  
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The same device input can be used for Rack input and Side-Chain simultaneously. You can 

preview your Side Chain input by clicking on speaker button. 
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7. Group Properties: Organization & Latency Alignment 

 

This window allows you to group several Racks together. Racks often have something in 

common, and it may make sense to assign all of these similar Racks to a latency group.  

Grouping all of the channels of your brass section, or drums, or audience, then assigning these 

groups a color; helps you to keep track of racks in concert situations. Also, each track will 

display the name of the group, further aiding quick visual organization. 

        

 

Plug-ins may impose a delay (known as “latency”) as signal passes through them. Often, this is 

not a problem. However, there are times you will want to time-align all of the Racks in a group, 

to compensate for different processor latencies that may cause phase-related problems.   

Use the LatencyGroup Properties window to create groups of racks and align their latencies. 

Open this window from the pull-down menu located at the top of a rack or from the Window 

menu. 

In the Group Properties window, you can create up to 16 processing groups, each of which 

can contain any number of Racks. 
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Create a group by double clicking on a Group Name cell and typing the name you want to 

assign the group (using the external keyboard). Now, decide how you want to align the 

processors within the group.  

None A group is created, but there is no latency alignment. 

Auto The group is delayed to match the latency of the rack in the group with the greatest 

total latency. 

Manual Manually delay the group by a specific value by entering it in the Latency field. The 

value is displayed in samples, milliseconds, meters or feet, depending on your choice 

in the pull-down window. The minimal value allowed for this setting matches the 

latency of the rack in the group with the greatest total latency. 

Groups are color-coded for easier identification. Color selection is based on placement in the 

list, and is not user-definable.  

At the bottom of the Group Properties page is the Align All section.  

 

Here you can align all of the groups of Racks in order to create a unified timing for all channels. 

The Auto setting will offset all of the groups to match the timing of the group with the greatest 

latency, while Manual will delay all groups by a specific value.  
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Below the Align All section is the “Speed of Sound” setting.  

 

This parameter control, expressed in meters per second, allows you to calibrate MultiRack 

SoundGrid’s latency controls to match measured speed of sound. The speed of sound at sea 

level, at a temperature of 20 degrees Celsius and dry air, is 343 meters per second.  
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8. Snapshot Pane: Automating Your Racks 

Snapshots contain the following parameters: 

1. Rack input and output gain 

2. Rack in/out, mute and on/off states 

3. Current plug-in parameters 

Snapshots are contained and saved as part of the Session file and are displayed as a vertical 

playlist. 

Use Snapshots to change the state of racks (Mute/In/Off), levels, and, most importantly, the 

settings for the plug-ins.  

Technical Note : Snapshots do not change the physical configuration of a Session, so 

you cannot use a snapshot to change the audio I/O, the rack order or the plug-ins 

embedded in a rack. 

To open the Snapshot Pane (fig. a), go to Waves tab >View> Open Snapshot Pane. 

   

Fig. A – MultiRack Snapshot Pane Fig B – DiGiCo Snapshot Window 
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To save a Snapshot of your existing rack environment, use the console’s Snapshot 

Management window (see Fig. B). Add Waves to the snapshot’s scope.  

When creating snapshots on the SD snapshot window, and Snapshot will automatically be 

created, with the same name, in the MultiRack’s Snapshot Pane. 

 

Note that selected snapshots are highlighted and the currently recalled snapshot’s name 

appears in boldface and its number is highlighted in as shown above. 

At the bottom of the SnapshotPane, under NOTES, is an area where you can write notes about 

the selected Snapshot. 
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Global Paste and Recall Safe Modes 

There are times when you don’t want certain racks or specific plug-ins to be affected by 

Snapshot changes and there are times that you wish to apply a setting of a plug-in or rack 

across several snapshots. 

The Global Paste and Recall Safe are the tools that provide you that ability. 

Global Paste 

"Global Paste" enables you to copy a plug-in’s or rack’s parameters into one or more other 

snapshots. This is useful when you’ve set up several racks filled with plug-ins and you decide to 

change plug-ins settings across several Snapshots.  

1. Recall the snapshot from which you want to copy settings. 

2. Touch the Global Paste “On” button.  

>  

3. Select the target snapshot/s that you want to modify. To select multiple snapshots, 

Ctrl+Click on the desired target snapshots, or Shift+Click to select several contiguous 

snapshots (using a mouse). 

4. In the rack windows, select the plug-in or rack to which to copy the selected snapshots 

to. Right-click on the plug-in and choose Global Paste Plug-in/Rack from the menu and 

touch the “Apply” button. Repeat this for each of the plug-ins or Racks whose settings 

you want to Global Paste.  

5. Touch the Global Paste button “On” in the snapshot Pane once again to turn this mode 

off and end the process. 
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Recall Safe 

Recall Safe Mode allows you to select the racks and/or plug-ins that won’t be affected as you 

change snapshots that would normally affect them. The recall-safe option applies within the 

session (not a specific snapshot).  

Turn Recall Safe Mode “On” in the Snapshots Pane  

>  

 

Racks: Select a Rack you want to set to Recall Safe. Touch the “Set” button or Right click on 

the selected Rack and choose Recall Safe from the pull-down menu. "Recall Safe" racks glow 

blue: 

 

Plug-ins: Select the plug-in you want to set to Recall Safe. Touch the “Set” button or Right click 

on the selected plug-ins and choose Recall Safe from the pull-down menu. "Recall Safe" plug-

ins glow blue: 
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To remove a rack or plug-in from "Recall Safe" mode, select the respective rack or plug-in and 

touch the “Unset” button or de-select "Recall Safe" from the right click pull-down menu. 

Plug-ins or racks that are set to "Recall Safe" can be edited. However, their "Recall Safe" status 

can be viewed only while in "Recall Safe" mode. Selecting "Recall Safe" in the Snapshots menu 

does not activate or de-activate "Recall Safe". Rather, it only allows you to see plug-ins and 

racks, and set them to "Recall Safe". When you turn "Recall Safe" mode off, racks and plug-ins 

which have been "Recall Safe" remain so; they just don’t glow blue. 

When a rack is "Recall Safe", all the plug-ins within that rack are affected, i.e. are effectively 

"Recall Safe" as well. 
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9. Saving in MultiRack SoundGrid 

 

MultiRack SoundGrid offers four different levels of “Save,” enabling you to quickly and 

confidently store and recall needed Session information. From most specific to most general, 

here are your options for saving information: 

 Per Plug-in: Each plug-in has its own WaveSystem Toolbar, so you can load and save 

your favorite plug-in settings without affecting the rest of the processing environment. 

Say you have a C4 preset that you’d like to use for the bass. Simply load the preset from 

the C4’s WaveSystem Toolbar’s Load menu. Plug-in settings can be saved to an 

external USB key and loaded on to another console, given that the same plug-ins are 

installed and authorized on both consoles. 

 Per Rack: There’s a WaveSystem Toolbar at the top of each rack, so you can load and 

save settings for an entire Rack, independent of the Snapshots. Plug-in settings can be 

saved to an external USB key and loaded into another console, given that the same 

plug-ins are installed and authorized on both consoles. 

 Sessions hold the settings for every plug-in and all racks. MultiRack Sessions are saved 

alongside the console’s Session file; both files are named identically and are loaded in 

synchronization when the corresponding console Session file is loaded. 

 Snapshots hold the settings for every plug-in and rack. Snapshots are created and 

stored on the console main Snapshot window. 

The chart below illustrates the relationship between Functions and Snapshots/Presets/Session 

management – within the Waves MultiRack and DiGiCo system, what stored in Plugin Preset, 

Rack Preset, Snapshot and Session. 

 Plug-ins Racks Snapshots  Session 

Rack Routing - - - All Racks 

Rack in/out gain - Single Rack All Racks All Racks 

Rack in/out and Mute 

state 

- Single Rack All Racks All Racks 
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Plug-ins chains and 

parameters 

Only Preset for 

individual plug-in 

All plug-ins in 

Single Rack 

All Plug-ins All Plug-ins 

 

10. Overview Window – Viewing the Status of All of 

Your Racks 

 

Once you’ve filled several racks, you’ll want a convenient way to keep track of everything 

happening within your processing environment. To get an overview of your racks, select 

Overview from the View menu. This will reveal the Overview Window, where you’ll see a 

condensed view of each Rack.  

 

The Overview Window tells you if a rack or an individual plug-in is functioning, and it enables 

you to turn on or off, bypass, or mute a Rack. Clipping is also indicated for each Rack. 
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Use the Overview Window when you want to keep an eye on the entire processing setup. Since 

each mini-Rack in the Overview Window displays clipping information, you can easily watch out 

for over-level clipping across your entire setup. 

11. Show Mode 

 

 

Show Mode is a “safe mode,” used during performances, that lets you adjust parameters within 

plugins, but not change routing, configuration, and other settings that could cause problems in a 

live situation.  

When Show is selected you’re locked out from much of the interface. 

To Switch between Setup and Show modes, go to the Master view->System tab->Security 

and switch between Setup and Live. 

>  

When choosing Setup, MultiRack will switch to Setup mode, when choosing Live, MultiRack will 

switch to Show Mode. 
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12. Automatic Recovery 

 

As MultiRack SoundGrid is an application for live shows, it is equipped with an automatic 

recovery mechanism. This means that if MultiRack SoundGrid quits unexpectedly, it will 

automatically re-launch and re-open the same session file it was running when it crashed, with 

the same snapshot that was recalled when the crash occurred (if applicable). While MultiRack 

SoundGrid re-launches itself, streaming and processing audio continues without interruption; 

only user control is lost until MultiRack SoundGrid re-loads its Session. 

13. Rescan Present Licenses 

 

 

If you are preparing a setup and routing without licenses (i.e. without a connected USB flash 

drive); the plug-ins will load in a disabled state. While the plug-ins won’t process audio you can 

still assign inserts, FX, load plug-ins and presets.  

To enable a disabled plug-in or plugins: 

 Connect your USB flash drive. 

 Go to Window Menu and select the “Rescan Present Licenses”. 

All disabled plugins will be enabled. 

 You can re-enable plugins individually by right clicking on disabled plug-in and choosing 

enable option from the menu. 
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14. System Monitor Window 

 

This Window offers general information to the SoundGrid system current state. To get to this 

window click go to the Audio menu and select the System Monitor item, or press CTRL+M. 

 

Open this window from the Window menu. 

This window displays real time status info on your SoundGrid network, I/O devices, and 
Servers. 

Redundancy   Displays redundancy status. 

Network Displays network transport load. High loads may result in audio 
drops. 

Processing/Redundant Server 

 Device – Device name 

 Status – Server status (online or offline) 

 CPU Peak and average loads (AVR) – Displays the load on the processing server. High 
loads may result in audio drops. 

I/O Device 1 and 2 (if available) 

 Device – Device name 

 Status – Device status 
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15. Dugan Automixer  

 

The Dugan Automixer plug-in is a MultiRack Native and SoundGrid plug-in only, integrated into 

the MultiRack system. The Dugan Automixer is inserted on the MultiRack’s outputs, post the 

Racks. All the Racks processing occurs prior to the signal reaching the Dugan Automixer plug-

in. For example, if MultiRack is inserted on console channels, then turning the Dugan Automixer 

On inserts the Automixer between Rack Outs and Insert Returns, as shown below. 

 

All available Outs are routed through the Dugan Automixer consecutively, thus Rack Outs 

routing values are identical to Automixer's channel number: Rack 1 Mono Out 1 connects to 

Automixer channel 1, Rack 2 Stereo Outs 3-4 connect to Automixer channels 3 and 4. 

When turning the Dugan Automixer On all its channels are bypassed by default. 

The Dugan Automixer is installed into the plug-ins folder, which is D:\Waves\Plug-ins V9. 

To open the Dugan Automixer go to the Waves tab under Advanced > Dugan Automixer or 

press F9. 

Close Automixer by clicking X on top right corner.  

Note that closing the Dugan Automixer window does not stops the automixer’s processing. It 

only closes its control window. 
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Dugan Channel Count 

 SD7 - The Dugan Automixer window opens 64 processing channels in 8 tabs. 

 All other SD models: The Dugan Automixer window opens 32 channels organized in 4 

tabs, the other 4 tabs will be grayed out.  

 

Snapshots - All plug-in controls are saved in the snapshots except for Master Pane controls. 

Master pane controls are not saved in Snapshots. 

Recall-Safe  - The Dugan Automixer can be Recall-Safed as a whole by clicking/pressing the 

Recall-Safe button on the plug-in’s Master Pane. Alternatively, right clicking on the top of Dugan 

Automixer window opens a menu where enabling/disabling Recall Safe is also possible. 

 

When The Dugan Automixer is On, an indicator will appear, on the MultiRack window, indicating 

the Automixer is On, as shown below.  

 

 

License & Session Behavior 

There are three possibilities: 

1. If the Dugan Automixer is not installed then on the Waves tab > Advanced menu item 

will show Dugan Automixer is Not Installed, and its settings will not be saved in the 

session file. When loading an existing session that contains Dugan Automixer 

processing, the session will load without the Automixer. The Automixer will not be 

removed from the session file. 
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2. If the Dugan Automixer is installed but not activated on the Waves tab > Advanced menu 

item will show Dugan Automixer is Not Activated, and its settings will not be saved in 

the session file. When loading an existing session that contains Dugan Automixer 

processing, the session will load with the Automixer disabled. The Automixer will not be 

removed from the session file.  

3. If the Dugan Automixer is installed and activated then its menu item will be shown 

normally. The Automixer will be saved in the session file even if it’s not turned On.  

Use Rescan Licenses to refresh activation for added licenses via the Waves Tab > Window > 

Rescan Present Licenses 

 

For more information please refer to the Dugan Automixer manual, by clicking on the question 

mark (?) on the plugins GUI.  
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16. Appendix 

MultiRack Menus 

 

Session View Window Advanced 

Import Multi Rack 

Session 

View/Hide Snapshot Pane Preferences Enable Verbose Mode 

Export Multi Rack 

Session 

Main View SoundGrid Inventory 

Overview  SoundGrid Connections 

Rack View  Latency Group Properties 

System Monitor 

Rescan Present Licenses  

About 

MultiRack SoundGrid Keyboard Shortcuts 

If you are using an external keyboard you may want to get familiar with MultiRack’s keyboard 

shortcuts. 

Session Item Definition Keyboard shortcut 

Import session Opens explorer window,  import session Ctrl+Alt+I 

Export session Opens explorer, export session Ctrl+Alt+E 

 

Window Item Definition Keyboard shortcut 

Open Snapshot Pane Opens/closes the Snapshot Pane in MultiRack 

SoundGrid window. 

F7 

SoundGrid Inventory Opens the SoundGrid Inventory Window F2 

SoundGrid Opens the SoundGrid Connections Window F3 
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Connections 

Group Properties … Opens the Group Properties window Ctrl+G 

System Monitor Opens the System Monitor window Ctrl+M 

Preferences Opens the Preferences window Ctrl+P 

 

Menu Item Definition Keyboard shortcut 

Main view Mode Opens the main application view (multiple Racks) F4 

Overview Mode Opens the overview view F5 

Rack view Mode Opens the Rack view F6 

Advanced Item Definition Keyboard shortcut 

Enable Verbose mode Creates Log file for troubleshooting.  

Rescan Present 

Licenses 

Starts rescan of licenses on connected USB flash 

drive   

Ctrl + L 
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